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1 Welcome 

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that 

can be used to monitor and control assets in space or on the ground.   

 

The TReK Generator application provides the capability to generate data and send it to 

one or more destinations.     

 

The topics in this user guide require an understanding of the topics covered in the TReK 

Concepts document.  Please be sure you have read the TReK Concepts document before 

reading this user guide. 

 

1.1 Getting Started 

Start with the Introduction which provides an application overview.  Next, try the Quick 

Start Guides for “How Tos” for common functions.  For help with details, reference the 

Details section.  See the FAQ and Troubleshooting section for helpful hints and solutions 

to the common “gotchas”. 

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK 

software, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:            trek.help@nasa.gov 

Telephone:      256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time) 

Fax:                 256-544-9353 

 

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time.  The HOSC Help Desk (256-544-5066) can provide assistance as needed 

and is available 24x7. 

 

 

3 Introduction 

The TReK Generator application provides the capability to generate data and send it to 

one or more destinations.  Data values can be randomly generated or specified by user-

defined data generation rules. 
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4 Overview of the User Interface 

4.1 Main Window 

The main window consists of three main areas as shown in Figure 1.  The top part of the 

main window contains the list of services.  A Service defines what data to generate, how 

to generate data values, and where to send the generated data.   When you start the 

Generator application the list will be empty.  The middle part of the window is the 

Statistics area.  Once you activate one or more services, the Statistics area will display 

statistics information about each service.  It will also provide information about the 

functions being performed like how many packets were generated and how many were 

forwarded.  The Statistics area can be reconfigured to show several different views.  The 

bottom part of the window is a message area that is used to display important status and 

information messages about the activities in progress.   

 

You may have noticed that each service row has a color associated with it.  The color 

provides information about the service.  For example, when using the default colors, if 

the packet row is black, this indicates that the packet has not been activated.  If the packet 

row is purple, this indicates that the service is initializing.  If the packet row is blue, this 

indicates the service has been activated but no data is being generated.  If the service row 

is green, this indicates that data is being generated and forwarded.  The colors are helpful 

in providing immediate information about the general configuration and status of each 

service in the list.  

 

Figure 1 shows two services in the Service area.  The first service in the list is named 

Science Data.   The Science Data service is configured to generate a data stream 

containing science data.   The status is Active and the color is green to indicate that data 

is being generated and forwarded.  The second service in the list is named Health and 

Status Data.  The status is Inactive and the color is black.  This indicates the service has 

been configured but not activated.  Until the service is active, the Generator application is 

not prepared to generate any data.  When a service is activated, it creates all the network 

sockets and other support needed to support the services requested.  As soon as a service 

goes Active, the application will start applying the configured services to generate and 

send the data. 

 

The Statistics area and the Message Area are dock windows that you can float or dock.  

To float a dock window, use your left mouse button to click and hold the title area while 

dragging the window to another area of the screen.  To dock, use the title bar to drag the 

dock window over the main window and drop. 
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Figure 1 Main Window 

 

Service Area 

The Service area provides a list of “Services”.  A Service defines what data to generate, 

how to generate the data values, and where to send the generated data. 

 

Statistics Area 

The Statistics area provides real time statistics information for active services. 

 

Message Area 

The Message Area displays important information, warning, and error messages.  The 

message area can be cleared using the View menu. 

 

 

4.2 Menus 

The application menus are:  File, View, Service, Options, and Help.  Each of these menus 

is described in more detail below. 

 

File Menu 

The File menu provides the capability to create a new configuration, open a 

configuration, save a configuration, and exit the application.   

 

View Menu 

The View menu provides the capability to clear the main window message area and show 

and hide the main window statistics and message area. 
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Service Menu 

The Service menu provides the capability to perform functions associated with services 

such as adding a service, activating a service, or deleting a service.  The service menu 

also shows context dependent menu items corresponding to the configuration of the 

service.  The context menu items will only appear when the service is active.  For 

example in Figure 2 the service selected is active so the capability to start sending 

packets is available from the menu.   

 

 

Figure 2 Service Menu Context Specific Menu Items 

   

Options Menu 

The Options menu provides the capability to access statistics, reset statistics, and 

configure statistics snapshot recording.  It also provides access to the Messages dialog 

which can be used to display and filter application messages.   

 

Help Menu 

The Help menu provides access to on-line help and application version information. 

 

 

5 Quick Start Guides 

This section provides “How Tos” for common functions. 

 

5.1 How to Add a Service 

This section describes how to add a service.  For additional information and details about 

the Add Service dialog please reference section 6.1. 
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1. To add a service, go to the Service menu and select Add Service. 

2. Enter a service name unique to this instance of the Generate application. 

3. To configure the application to generate data, enter the information about the data to 

generate on the Generate tab.   

4. To forward the generated data, enter the forwarding information on the Forward Tab.  

You can specify to forward data to one or more destinations selecting the 

communication protocol to use for each destination. 

 

5.2 How to Activate a Service 

This section describes how to activate a service.  

 

1. To activate a service, select the service in the Main Window Service Area.  Then go 

to the Service menu and select Activate Service. 

 

Note:  There is also a context sensitive pop-up menu available in the Main Window 

Service Area.  Select the service in the list and then use the right mouse button to access 

the pop-up menu and select Activate Service. 

 

5.3 How to Deactivate a Service 

This section describes how to deactivate a service.  

 

1. To deactivate a service, select the service in the Main Window Service Area.  Then 

go to the Service menu and select Deactivate Service. 

 

Note:  There is also a context sensitive pop-up menu available in the Main Window 

Service Area.  Select the service in the list and then use the right mouse button to access 

the pop-up menu and select Deactivate Service. 

 

5.4 How to Start and Stop Data Generation 

This section describes how to start and stop data generation.  

 

1. Select a service in the Service List.  If the service is not active, activate the service.  

The service must be active before you can start generating data. 

2. To start generating data, select the service in the Service List, go to the Service menu, 

and select Start Packets.  You can also use the context sensitive pop-up menu in the 

Service Area to select Start Packets.  If this is successful, the service will turn green. 

3. To stop the data generation select the service in the Service List, go to the Service 

menu, and select Stop Packets.  The service will turn gold to indicate it is no longer 

generating data.   

4. When starting and stopping data generation important status and/or error messages 

will be displayed in the Main Window message area. 
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6 Details 

This section covers various application details. 

 

6.1 Service 

The Service dialog is used to define what data to generate, how to generate data values, 

and where to send the generated data.  The Service configuration can only be modified 

when the Service is inactive.  The Add Service dialog is show in Figure 3.  Details are 

provided below. 

 

 

Figure 3 Add Service Dialog 

 

 

Service Name 

Each Service must have a unique name. 

 

6.1.1 Service Dialog (Generate Tab) 

The Service Dialog Generate tab is shown in Figure 4.   The Generate tab is used to enter 

metadata information for each packet to be generated.  You can select metadata 

definitions from a TReK database or browse the disk for metadata files.  You can 

generate one or more packets.  Once you have identified a packet to generate you can use 

Configure to specify how the data should be generated.  The Delete button can be used to 

delete a metadata definition from the list.  Figure 5 shows the PdssPayloadApid7 
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metadata definition in the Packet Information List.  To configure the generation of this 

packet, select the metadata definition in the list and push the Configure button.  The 

Configure dialog shown in Figure 6 will be displayed.  This dialog provides the 

capability to set the packet rate, the duration, and the option to auto-generate the packet 

data values or use rules defined in a user defined generator file.  You can use the Browse 

button to select a user defined generator file.  Information on defining a generator file can 

be found in 6.2.1.  An example generator file is provided in 6.2.2.  When you select to 

auto-generate a data file, the autogen file will be created and placed in the TReK 

Workspace/generator_file directory.  The file will be named autogen_<packet key> (e.g. 

autogen_PdssPayload.RT.PL.7). 

 

 

Figure 4 Add Service Dialog (Generate Tab) 
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Figure 5 Add Service Generate Tab with Packet to Generate 

 

 

 

Figure 6 Configure Generator Properties 

 

 

 

6.1.2 Service Dialog (Forward Tab) 

The Service Dialog Forward tab is shown in Figure 7.  The Forward tab is used to 

configure the service to forward generated data. 
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Figure 7 Service Dialog (Forward Tab) 

 

 

Each field is described below. 

 

Destination List Tab 

The destination list is used to identify the list of destinations to which the data should be 

forwarded.  Data can be forwarded to a network destination or a Delay Tolerant Network 

(DTN) destination.   

 

A network destination example is shown in Figure 8.  For a network destination, each 

destination must include a user defined name that is unique in this destination list, a 

Protocol, and the applicable settings required for the protocol selected. The Protocols 

supported are UDP and TCP.  The Protocol menu provides the capability to select the 

type of socket to use when forwarding the data:  UDP, TCP Client, or TCP Listener 

socket.  Figure 8 shows three different destinations in the Destination List.   When using 

a TCP Listener socket it is not necessary to define a Destination IP Address or a 

Destination Port.  When the Local Port is set to 0, the operating system will automatically 

select a port to use for the socket that is created to send data to the destination.  This is 

the default as it saves you the trouble of keeping up with ports.  However, you can enter a 

specific port if you would like.  This is advisable if you are using a TCP Listener socket 

since another party will be connecting to the socket.  The Add and Delete buttons are 

used to add a row to the list and delete a row from the list respectively.  The Set Local IP 

Address button can be used to browse for a local IP address and set the value in selected 

Local IP Address cells. 
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Figure 8 Forward Network Destination List 

 

A DTN destination example is shown in Figure 9.  For a DTN destination, each 

destination must include a destination node number and a destination service number.  

General properties that must be input for all DTN destinations include Source Service 

Number, Lifespan, Bundle Protocol Class of Service, Expedited Priority Ordinal, 

Transmission Mode, and Criticality.  Each field is described below. 

 

Source Service Number 

The source service number is ION’s configured BP service number.  This number is used 

to receive packets from ION.  

 

Lifespan 

The lifespan is the bundle's "time to live" (TTL) in seconds. The bundle is destroyed if its 

TTL has expired and it has not reached its destination. Minimum value is 1, maximum 

value is 2,147,483,647 and the default value is 86400. 

 

Bundle Protocol Class of Service 

The BP class of service defines the transmission priority of outbound bundles from three 

ION priority queues corresponding to Bulk Priority, Standard Priority, and Expedited 

Priority. The expedited priority queue must be empty before bundles in the standard or 

bulk queues are serviced by ION. Therefore, bundles with Expedited Priority should only 

be sent in critical/emergency situations. The default value is Standard Priority.  
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Expedited Priority Ordinal 

The expedited priority ordinal is only associated with the Expedited Priority class of 

service. Ordinal values range from 0 (lowest priority) to 254 (highest priority). The 

default value is 0. 

 

Transmission Mode 

The transmission mode defines the reliability of bundle delivery to a destination. The 

three transmission mode parameter values are Best Effort, Assured, and Assured with 

Custody Transfer. Best Effort relies upon the underlying convergence-layer protocol (e.g., 

Transmission Control Protocol or TCP) to retransmit missing bundles. Assured is a step 

up in reliability and includes BP support in detecting a lost TCP connection and re-

forwarding of bundles assumed aborted by the convergence-layer protocol failure. 

Assured with Custody Transfer requires the reception, by the sending node, of a custody 

acceptance or refusal signal (packaged in a bundle) from the receiving node. The default 

value is Assured. 

 

Criticality 

A critical bundle is one that has to reach its destination as soon as is physically possible. 

For this reason, bundles flagged as critical may not include custody transfer and require 

an ION configuration with contact graph routing. In some cases, a critical bundle may be 

sent over multiple routes to ensure delivery to its final destination. Critical bundles are 

placed in the expedited priority queue and should only be used in emergency situations. 

The two criticality parameters are Not Critical and Critical. The default value is Not 

Critical. 

 

 

Figure 9 Forward DTN Destination List 
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Transform Tab 

The Transform tab is shown in Figure 10.  The Transform tab provides the capability to 

enable the transform feature which can be used to remove a specific number of bytes 

from the beginning of each packet before the packet is forwarded. 

 

 

 

Figure 10 Service Dialog Forward Tab Transform 

 

Encrypt Tab 

The Encrypt tab is shown in Figure 11.   The Encrypt tab provides the capability to 

encrypt data sent to a destination.  Encryption is controlled per destination.  
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Figure 11 Service Dialog Forward Tab Encrypt Network Destination 

 

 

 

 

 

Figure 12 Service Dialog Forward Tab Encrypt DTN Destination 
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The Peer Public Key Information is populated using the Destination List.  To encrypt 

data going to a specific destination, check the Encrypt Outgoing Data checkbox, and 

identify the absolute path to the Peer Public Key associated with that destination.  The Set 

Peer Public Key button is used to browse the local disk for a peer public key file.  The 

Clear Peer Public Key button is used to clear a peer public key pathname.  One or more 

rows must be selected to use the Set Peer Public Key and Clear Peer Public Key buttons. 

 

 

6.2 Generator File 

This section describes the file used by the Generator application to auto-generate data 

values based on specific rules.  You can create your own file to change the default 

behavior of the generated data or the file can be autogenerated from any existing packet 

definition.  The following sections include a description of the generator file format and 

an example. 

 

6.2.1 Generator File Format 

The generator file is read one line at a time (maximum line size is 10,000 bytes).  Any 

characters after a # is treated as a comment.  Keywords are not case sensitive but are 

generally shown as all uppercase.  Checks are performed as the file is read to make sure 

each keyword has the appropriate number and type of arguments available.  Additional 

checks may occur later depending on the keyword.  Each keyword and the required 

arguments are explained below.  The overall structure of the file will be described later. 

 

Note:  Strings with spaces are supported with double quotes. 

 
FIXED – Describes a fixed value that requires two arguments: 

 

 FIXED <name> <value> 

 

• <name> - The name for this value.  The name must be unique for all values (not just 

fixed values).  The name is used as a reference to apply the value to an actual 

parameter name. 

• <value> - The value to use.  Since this could really be any data type no type checks 

are made here.  When the value is applied, type checks are performed (e.g., if you 

used the value for an unsigned integer, a check makes sure only digits appear). 

 

SYSTIME – Describes a system time that requires two arguments: 

 

 SYSTIME <name> <offset> 

 

• <name> - The name for this value.  The name must be unique for all values. 
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• <offset> - This is the offset (+/-) to the system time to be used.  If you just want 

system time a value of 0 should be used.  The value is read as a floating point 

number. 

 

RAMP – Describes a ramping value that requires five arguments: 

 

 RAMP <name> <start> <delta> <min> <max> 

 

• <name> - The name for this value.  The name must be unique for all values. 

• <start> - The start value.  This value is confirmed to be numeric here, but additional 

checks would be made if applied to an integer.  The same type of checks are made 

for each of the other values. 

• <delta> - The value to increment after each use.  Can be positive or negative. 

• <min> - The minimum value for the ramp.  The start will be adjusted to this value if 

the start value is less than the minimum. 

• <max> - The maximum value for the ramp.  The start will be adjusted to this value if 

the start value is greater than the maximum. 

 

RANDOM – Describes a random value.  Requires three arguments. 

 

 RANDOM <name> <min> <max> 

 

• <name> - The name for this value.  The name must be unique for all values. 

• <min> - The minimum value that will be generated.  First check is that the value is 

numeric, but additional checks are performed later if applied to an integer. 

• <max> - The maximum value that will be generated. 

 

ROTATE – Values that are rotated through.  Once all values are used, 

the rotation starts over.  Requires at least 3 arguments. 

 

 ROTATE <name> <value1> <value2>…<value n> 

 

• <name> - The name for this value.  The name must be unique for all values. 

• <value[n]> - The values to rotate through.  No checks made here on the values, but 

checks will be made as appropriate (e.g., if applied to a numeric parameter). 

 

OVERWRITE – Provides a means of overwriting the generated data with 

different patterns.  Overwrites are applied after the packet is built.  

If overwrites are applied to the same place in the packet, the order 

the overwrites are made is not guaranteed.  There are five arguments 

required. 

 

 OVERWRITE <type> <name> <start> <len> <data> 

 

• <type> - The type of overwrite.  Must be one of the following: 

▪ STR – The <data> will be interpreted as a string value. 
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▪ BIN – The <data> will be interpreted as a binary value. 

▪ HEX – The <data> will be interpreted as a hexadecimal value. 

• <name> - The name of the overwrite.  This namespace is unique to overwrites so a 

value name for a parameter could be reused if desired. 

• <start> - The start location of the overwrite in bits.  Start is from the beginning of 

the entire packet. 

• <len> - The length of the overwrite in bits. 

• <data> - The data to overwrite (read based on the <type>).  Checks are performed 

as appropriate (e.g., to make sure data is binary and the number of bits defined 

match up with the length specified). 

 

OW_START – Applies the overwrite.  Overwrite will be applied until a 

OW_STOP is received.  Requires one argument: 

 

 OW_START <name> 

 

• <name> - The name from the OVERWRITE directive.  It will fail if one doesn’t exist 

with this name. 

 

OW_STOP – Stops applying the overwrite.  Requires one argument: 

 

 OW_STOP <name> 

 

• <name> - The name from the OVERWRITE directive. 

 

SET – Sets a parameter to use a generator value.  You can use the same 

generator multiple times, but each parameter will get its own copy.  

Requires two arguments: 

 

 SET <param> <value> 

 

• <param> - The parameter name from the Packet object. 

• <value> - The <name> from one of the following directives:  FIXED, RAMP, 

RANDOM, ROTATE, or SYSTIME. 

 

AT – Defines the beginning of an “AT group”.  All lines after this are 

interpreted as part of this AT group until another AT directive is 

found.  Values are applied as part of the AT group using the SET, 

OW_START, and OW_STOP keywords.  Requires two arguments: 

 

 AT <type> <value> 

 

• <type> - Either TIME or PKT. 

• <value> - If the <type> is TIME, value is interpreted as a floating-point value 

indicating the number of seconds after start to apply the change.  If the <type> is 
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PKT, value is interpreted as an unsigned integer indicating after how many packets 

to apply the change. 

 

6.2.2 Generator File Example 

This section provides an example of a generator file.  The example shown below is the 

autogenerated file version of APID 314 which is part of the Metadata Tutorial.   

 
# CP=Version has value defined in packet definition. 

# CP=Type has value defined in packet definition. 

# CP=SecHdrFlag has value defined in packet definition. 

# CP=APID is a packet attribute and will not have a value defined. 

# CP=SeqFlags has value defined in packet definition. 

# CP=SeqCount is a packet attribute and will not have a value defined. 

# CP=PktLength is a packet attribute and will not have a value defined. 

# CS=Time is a packet attribute and will not have a value defined. 

# CS=TimeID has value defined in packet definition. 

# CS=CheckwordIn has value defined in packet definition. 

# CS=ZOE has value defined in packet definition. 

# CS=PktType has value defined in packet definition. 

# CS=VersionID has value defined in packet definition. 

# CS=DCCounter has value defined in packet definition. 

FIXED UINT_16Value 0 

FIXED INT_32Value 0 

RANDOM FEEE_64Value -5.0 5.0 

FIXED SUND_80Value 00010203040506070809 

 

AT TIME 0 

SET UINT_16 UINT_16Value 

SET INT_32 INT_32Value 

SET FEEE_64 FEEE_64Value 

SET SUND_80 SUND_80Value 

 

The generator file is by convention divided into two sections, but the keywords do allow 

more flexibility.  The first section is the definition of the parameter values.  The 

autogenerated values are based on the datatype and are likely something you will want to 

change.  The values are defined by the FIXED, RANDOM, RAMP, ROTATE, and 

SYSTIME keywords described in the previous section. 

 

The second section is where each parameter in a packet gets assigned a value.  The AT 

group defines when to apply the value.  Autogenerated files will always have an AT 

group defined for time zero (AT TIME 0) that assigned the defaults to each parameter.  

You can add more parameter values and assign them either in the default AT group or 

create new AT groups.   

 

A few examples may help explain the concepts.  The examples will only have the new 

content, but the complete file can be found after the examples. 

 

Example 1:  Add rotating values for an unsigned integer. 
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The first addition to make is the keyword ROTATE that will define the values to be 

rotated: 

 
      ROTATE MyRotateValue 1 3 5 7 9 

 

Now you must say when to apply this value.  You could change the original SET 

keyword for parameter UINT_16 in the default AT group to use this value, but we’ll 

create a new AT group to apply it later. 

 
      AT TIME 10.5 

      SET UINT_16 MyRotateValue 

 

This will change how the UINT_16 value is generated after 10.5 seconds have passed and 

will continue to be used unless another AT group changes the value used. 

 

Example 2:  Add a ramp value for a signed integer. 

The first addition to make is the keyword RAMP that will define how the values will 

change over time.  We’re going to use lowercase for the keyword here since keywords 

are not case-sensitive. 

 
      ramp MyRamper 10 -1 0 100 

 

We’ll apply this value with an AT group based on the packet count.  AT groups that are 

triggered by packet count can be useful if you want to vary the packet rates, but always 

have the same data in the packet. 

 
      AT PKT 30 

      SET INT_32 MyRamper 

 

After 30 packets are sent the value for INT_32 is changed.  If you are sending one packet 

a second, this would trigger after the first example.  If you are sending 10 packets a 

second, this would trigger before the first example. 

 

Example 3:  Overwrite the APID value in the header. 

It’s not suggested that you overwrite values used to identify the packet because that will 

mean the packet won’t be identified, but it is a good example to show the behavior.  First 

let’s define an overwrite.  The APID starts at bit 5 and is 11 bits long.  The value 

generated is 314 (in binary 00100111010).  Just flipping the last bit is enough (changing 

the value to 315). 

 
      OVERWRITE BIN MyOverwrite 15 1 1 

 

The overwrite is applied as part of the AT group.  In this case we are going to only use 

the overwrite for one packet so we will also create an AT group to remove the overwrite. 

 
      AT PKT 10 

      OW_START MyOverwrite 

 



TREK-USER-0034 

 19 

      AT PKT 11 

      OW_STOP MyOverwrite 

 

If you use this generator file to send packets, the 10th packet will have an APID value of 

315.  This will show up in the Data application as a new packet and will also cause a 

sequence error in APID 314. 

 

The complete file (autogenerated contents plus modifications) is shown below. 

 
# CP=Version has value defined in packet definition. 

# CP=Type has value defined in packet definition. 

# CP=SecHdrFlag has value defined in packet definition. 

# CP=APID is a packet attribute and will not have a value defined. 

# CP=SeqFlags has value defined in packet definition. 

# CP=SeqCount is a packet attribute and will not have a value defined. 

# CP=PktLength is a packet attribute and will not have a value defined. 

# CS=Time is a packet attribute and will not have a value defined. 

# CS=TimeID has value defined in packet definition. 

# CS=CheckwordIn has value defined in packet definition. 

# CS=ZOE has value defined in packet definition. 

# CS=PktType has value defined in packet definition. 

# CS=VersionID has value defined in packet definition. 

# CS=DCCounter has value defined in packet definition. 

FIXED UINT_16Value 0 

FIXED INT_32Value 0 

RANDOM FEEE_64Value -5.0 5.0 

FIXED SUND_80Value 00010203040506070809 

  

ROTATE MyRotateValue 1 3 5 7 9 

ramp MyRamper 10 -1 0 100 

OVERWRITE BIN MyOverwrite 15 1 1 

 

AT TIME 0 

SET UINT_16 UINT_16Value 

SET INT_32 INT_32Value 

SET FEEE_64 FEEE_64Value 

SET SUND_80 SUND_80Value 

 

AT TIME 10.5 

SET UINT_16 MyRotateValue 

 

AT PKT 10 

OW_START MyOverwrite 

 

AT PKT 11 

OW_STOP MyOverwrite 

 

AT PKT 30 

SET INT_32 MyRamper 

 

6.2.3 How Data Is Generated 

Every parameter in the packet must have a value before the packet can be generated.  The 

auto-generation feature will populate a text file with default values for every parameter in 
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the packet.  The file will be created in the TReK workspace generator_file folder with the 

name autogen_<packet key>.  You can copy this file and rename it to make changes to 

set values according to your needs. 

 

The first thing to occur prior to sending each packet is to check if there are any changes 

to be made to how values are generated (AT directives).  The order that these changes are 

made are first by TIME and then by PKT count. 

 

The next thing to happen is all the possible parameters in the packet are updated with 

another value.  For data that is marked FIXED it won’t change at all, but RANDOM, 

RAMP, and ROTATE values will go to the next value.  Note:  All values are updated, but 

there are cases (e.g., formats or counter dependent parameters) where all the parameters 

may not appear in a packet.  This can cause parameter values to seem to ‘skip’ in the 

resulting data stream. 

 

After all the values are updated, the packet is built.  Prior to sending the packet any 

overwrites are applied to the binary packet data.  Once the overwrites are applied, then 

the packet is sent and the process begins over again. 

 

6.3 Statistics 

Statistics displays information about incoming data and services such as processing, 

recording, and forwarding.  Statistics information is displayed in a dock window in the 

Main Window and in the Statistics dialog available from the Options menu.  Figure 13 

shows the Statistics dock window in the Main Window.  Figure 14 shows the Statistics 

dialog. 
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Figure 13 Statistics in the Main Window 

 

 

 

Figure 14 Statistics Dialog 

 

 

Statistics can be configured to display different views of the statistics information.  The 

view options can be accessed using the Statistics area pop-up menu.  The pop-up menu is 

shown in Figure 15 and can be accessed by clicking the right mouse button in the 

statistics area.  
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Figure 15 Statistics Pop-Up Menu 

 

The Statistics pop-up menu has several options.  Each is described below: 

 

Show Service Statistics 

Service Statistics is the default view.  It is shown in Figure 13.  This view shows statistics 

associated with each service in the service list.   

 

Show Service Device Statistics 

Service Device Statistics shows the same information as Service Statistics with the 

addition of devices that are used by the service.  Figure 16 shows an example of a service 

configured to generate and forward data.  In this view you can see the service is 

configured to generate data and forward the data on a unicast socket.  Figure 17 shows 

the view after some data has been generated.  Each row is described below: 

 

Packet 7 Service:  Indicates five packets were generated and five packets were forwarded. 

 

Unknown:  The Generator application can support multiple types of packets in a single 

service.  The Unknown row represents the total statistics for all the packet types in use 

for that specific service. 

 

4.Packet7ServiceGeneratorLibrary:  This item is a generator library device created 

behind the scenes to generate data.  This shows that five packets were generated by the 

Packet Generator Library. 
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1.1.127.0.0.1.49488.1:  This item represents the socket used to forward data.  The IP 

address is 127.0.0.1 and the port is 49488.  This shows that five packets were forwarded 

using this unicast socket. 

 

 

Figure 16 Service Device Statistics 
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Figure 17 Service Device Statistics After Sending Data 

 

Show Device Statistics 

Device Statistics displays all the network sockets or devices in use by all active services 

being used to generate or forward data.  When the device is a network socket it will 

include the IP address and Port.  When the device is a library device that performs a 

specific function, such as handling bundle protocol data, the name will reflect the 

device’s function.  Figure 18 shows the device statistics view.  In this example, there is 

one network socket and one Packet Generator Library displayed.  When data is generated 

by the Packet Generator Library the Pkts Sent column will update reflecting the number 

of packets generated.  When data is forwarded on the network socket the Pkts Sent 

column will update reflecting the number of packets forwarded. 
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Figure 18 Device Statistics View 

 

Expand All 

The Expand All option will expand the Statistics tree to show all items if applicable for 

that specific view. 

 

Configure Statistics 

The statistics information displayed can be configured using the Configure Statistics 

dialog.  This dialog can be accessed using the statistics pop-up menu or the Configure 

button in the Statistics dialog.  Detailed information is covered in section 6.3.1. 

 

Reset Statistics 

Reset Statistics will reset all statistics in all views to zero. 

 

 

6.3.1 Configure Statistics Dialog 

The Configure Statistics Dialog is context dependent based on the current statistics 

configuration.  It provides the capability to show and hide columns.  Each configuration 

is described below. 

 

Service and Service Device Statistics Configuration 

The Configure Statistics Dialog shown in Figure 19 is displayed when the statistics 

configuration is set to Service Statistics or Service Device Statistics. 
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Figure 19 Configure Statistics Dialog (Service and Service Device) 

 

Each field is described below. 

 

Name 

Name corresponds to the service in the main window service list.  

 

Item Type 

Item Type identifies the type of item for which statistics are being provided. 

 

Service Function Columns 

The Generate and Forward columns provide statistics associated with those specific 

functions.  For example, the Generate column indicates how many packets have been 

generated and the Forward column indicates how many packets have been forwarded. 

 

Configure Statistics (Device Statistics) 

The Configure Statistics Dialog shown in Figure 20 is displayed when the statistics 

configuration is set to Device Statistics.   
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Figure 20 Configure Statistics Dialog (Device Statistics) 

 

Each field is described below. 

 

Name 

Name is a character string that uniquely identifies each device and packet type.  The 

device name is the device key if no device name is provided when the device is created.  

The packet name is the packet key associated with the packet.   

 

State 

State is the current state or condition of a device.  Valid states include Start, Stop, 

Pause, Pulse, Ready and Undefined.  If you check the State checkbox, the State column 

will be displayed. 

 

Receive State 

Receive State is the current receive state of an object.  Valid receive states include Ready 

To Receive, Receiving and Not Receiving. If you check the Receive State checkbox, the 

Receive State column will be displayed. 

 

Send State 

Send State is the current receive state of an object.  Valid receive states include Ready To 

Send, Sending and Not Sending. If you check the Send State checkbox, the Send State 

column will be displayed. 

 

Device Key 

Device Key is a character string that uniquely identifies each device.  If you check the 

Device Key checkbox, the Device Key column will be displayed. 
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Pkts Rcvd  

Packets received represents the number of packets received.  If you check the Pkts Rcvd 

checkbox, the Pkts Rcvd column will be displayed. 

 

Pkts Sent 

The number of packets sent to a destination. If you check the Pkts Sent checkbox, the 

Pkts Sent column will be displayed. Pkts Sent is not the same as packets forwarded. Pkts 

Sent is used to represent the number of packets sent across a socket that is configured to 

receive and send packets. 

 

Seg Rcvd 

Segments Received represents the number of segments received.  This column is only 

applicable for TCP.  If you check the Seg Rcvd checkbox, the Seg Rcvd column will be 

displayed. 

 

Queue Size 

Queue Size is the size of the queue that temporarily buffers packets that are being 

processed by a device.  A device does not have to be associated with a queue.  The 

device’s queue size is defined when the device is created.  If you check the Queue Size 

checkbox, the Queue Size column will be displayed. 

 

Host Name 

Host Name is a unique identifier that serves as the name of the computer. If you check 

the Host Name checkbox, the Host Name column will be displayed. 

 

IP Address 

IP Address is the IP address of a device if the device is a socket.  If you check the IP 

Address checkbox, the IP Address column will be displayed. 

 

Port 

Port is the port number of the device if it is a socket.  The port number is a string 

identifying the type of socket (e.g., client, listener or server) formatted as “c/l/s”.  If the 

socket is a client socket then the port number will be followed by two "/" (e.g., 6100//).  

If the client socket is connected to a listener socket, the listener's port number is also 

listed (e.g., 6100/5432/).  If the socket is a server socket then the client port number that 

is connected to the server is listed first, followed by two "/" and the server's listener port 

number (e.g., 6100//7890).  If the socket is a listener socket the listener's port number is 

listed between two "/" (e.g., /5555/).  If you check the Port checkbox, the Port column 

will be displayed. 

 

Protoface 

Protoface is the IP transportation protocol, either TCP or UDP, of a socket device.  If you 

check the Protoface checkbox, the Protoface column will be displayed. 
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Recv Pkt Rate 

Receive Packet Rate represents the number of packets received in the last second.  If you 

check the Recv Pkt Rate checkbox, the Recv Pkt Rate column will be displayed. 

 

Max Recv Pkt Rate 

Maximum Receive Packet Rate represents the maximum packet rate seen thus far.  If you 

check the Max Recv Pkt Rate checkbox, the Max Recv Pkt Rate column will be 

displayed. 

 

Recv kbit Rate 

Receive kilobit Rate represents the current number of kilobits per second that are being 

received.  If you check the Recv kbit Rate checkbox, the Recv kbit Rate column will be 

displayed. 

 

Max Recv kbit Rate 

Maximum Receive kilobit Rate represents the maximum kilobit rate seen thus far.  If you 

check the Max Recv kbit Rate checkbox, the Max Recv kbit Rate column will be 

displayed. 

 

Send Pkt Rate 

Send Packet Rate represents the number of packets sent in the last second.  If you check 

the Send Pkt Rate checkbox, the Send Pkt Rate column will be displayed. 

 

Max Send Pkt Rate 

Maximum Send Packet Rate represents the maximum packet rate sent thus far.  If you 

check the Max Send Pkt Rate checkbox, the Max Send Pkt Rate column will be 

displayed. 

 

Send kbit Rate 

Send kilobit Rate represents the current number of kilobits per second that are being sent.  

If you check the Send kbit Rate checkbox, the Send kbit Rate column will be displayed. 

 

Max Send kbit Rate 

Maximum Send kilobit Rate represents the maximum kilobit rate sent thus far.  If you 

check the Max Send kbit Rate checkbox, the Max Send kbit Rate column will be 

displayed. 

 

Rcvd Pkts Drop 

Received Packets Dropped represents the number of packets that TReK received and then 

dropped.  If you check the Rcvd Pkts Drop checkbox, the Rcvd Pkts Drop column will be 

displayed. 

 

Send Pkts Drop 

Send Packets Dropped represents the number of packets that TReK attempted to send but 

dropped.  If you check the Send Pkts Drop checkbox, the Send Pkts Drop column will be 

displayed. 
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Pkts Drop 

Packets Dropped represents the number of packets that were dropped because they could 

not be processed by another device.  If you check the Pkts Drop checkbox, the Pkts Drop 

column will be displayed. 

 

Seg Drop 

Segments Dropped represents the number of segments that TReK received and then 

dropped.  This column is only applicable for TCP.  If you check the Seg Drop checkbox, 

the Seg Drop column will be displayed 

 

Pkt Seq Err 

Packet Sequence Error represents the number of packet sequence errors that occurred for 

a packet that is being received. A packet sequence error occurs when a packet arrives out 

of order (i.e. a packet with a sequence count of six was expected but instead a packet with 

a sequence count of seven was received). This calculation assumes a zero sequence count 

implies a sequence count reset and is not considered a packet sequence error.  If you 

check the Pkt Seq Err checkbox, the Pkt Seq Err column will be displayed. 

 

Max Pkt Seq Err 

Maximum Packet Sequence Error represents the maximum packet sequence error that 

occurred for a packet that is being received. TReK determines the maximum packet 

sequence error by calculating the delta or difference between the expected packet 

sequence count and the actual packet sequence count.  This calculation assumes a zero 

sequence count implies a sequence count reset and is not considered a packet sequence 

error.  If you check the Max Pkt Seq Err checkbox, the Max Pkt Seq Err column will be 

displayed. 

 

Set To Defaults 

Set To Defaults will set all the fields to their default values. 

 

6.4 Configure Statistics Snapshot Recording Dialog 

The Configure Statistics Snapshot Recording dialog is shown in Figure 21.  Statistics are 

generated and captured in memory as you use the application.  A snapshot of the statistics 

can also be recorded to a file by turning on Statistics Snapshot Recording.   When 

Statistics Snapshot Recording is on, the snapshot is updated once a second with the latest 

statistics and written to a file.  Previous statistics snapshot information is overwritten 

each time the latest statistics information is written to the file.  Statistics are only 

available when there are services that are active.  If you deactivate all services before 

turning off Statistics Snapshot Recording, the statistics snapshot file will be empty. 
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Figure 21 Configure Statistics Snapshot Recording Dialog 

 

 

Each field is described below: 

 

Record Statistics Snapshot 

The application provides the capability to write a snapshot of application statistics to a 

file.  If you check Record Statistics Snapshot, a snapshot of the application statistics will 

be written to the file specified. 

 

File Path 

The File Path should contain the absolute path to the directory where the statistics 

snapshot file should be written. 

 

File Name 

The File Name field should contain the name to use for the statistics snapshot file. 

 

Include Packet Statistics 

The Include Packet Statistics checkbox specifies whether packet statistics should be 

written to the file. 

 

6.5 Manage Cryptography Settings Dialog 

The Manage Cryptography Settings dialog is shown in Figure 22.  It is used to enter 

cryptography settings.  The Cryptography checkbox must be checked and all required 

cryptography settings must be populated with valid information in order to successfully 

activate a service that uses cryptography capabilities. 
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Figure 22 Manage Cryptography Settings Dialog 

 

Each field is described below. 

 

Cryptography Checkbox 

The Cryptography checkbox is used to specify you want to use cryptography services.  

 

Public Key Pathname 

This is the absolute path for the public key file. 

 

Private Key Pathname 

This is the absolute path for the private key file. 

 
Use Passphrase 

The Use Passphrase checkbox is used to specify that the private key requires a passphrase.  If 

this box is checked, the passphrase must be entered into the text field.  The passphrase text 

will not be displayed in the clear.  If you want to see the text entered in the clear, check the 

Show Text checkbox.  This information is not stored when you save a configuration.  You 

will have to enter it each time you restart the application when using cryptography services. 

 

Show Text 

The Show Text checkbox is used to display the passphrase text in the clear. 

 

Cipher Class 

This option menu is used to select the cipher class. 

 

Packet Key Encryption Period 

As mentioned in the TReK Cryptography Services Tutorial, cryptography keys are used 

to generate other keys behind the scenes.  One of these keys is called a Cipher Encryption 
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Key (CEK).  The Packet Key Encryption period defines how often to generate a new 

Cipher Encryption Key (CEK) when streaming encrypted data.  It can be configured to 

generate a new CEK for a packet stream once every "x" seconds to support encryption of 

high rate packet streams.  The time period is measured in seconds.  If the packet key 

encryption period is set to zero, the TReK encryption library will generate a new packet 

encryption key for every packet in the stream.  The TReK encryption library can support 

the encryption of high rate packet streams by setting the packet key encryption period to 

a non-zero value.  The default value is 10 seconds. 

 

 

6.6 Application Messages 

Various types of application messages are generated including information, progress, 

warning, error, and debug messages.  Application messages are stored in memory and 

written to a temporary log file.  The temporary log file is created on application 

initialization and exists as long as the application is running.  It is deleted when you exit 

the application.  The log file is located in the temporary directory provided by the 

operating system.  Only a subset of messages are stored in memory while all messages 

are written to the temporary log file.  The maximum number of application messages 

stored in memory is controlled by the message storage setting in the Configure Messages 

dialog.  Once the maximum is reached, older messages are deleted to make room for new 

messages.  Setting the maximum value to a large number can impact application 

performance since it will increase the amount of memory used by the application.  Setting 

this number too low can cause you to miss important messages.  The application default 

was selected to protect against both of these scenarios.  Messages stored in memory are 

displayed in the Main Window Message Area and the Messages dialog.  The Messages 

dialog is shown in Figure 23.  The Main Window message area only displays Info, 

Warning, and Error messages.  The Messages dialog displays messages based on the 

display preferences defined in the Configure Messages dialog.  By default, the Messages 

dialog will display information, progress, warning, and error messages.  Columns in the 

Messages dialog can be sorted by clicking on the column header.  The Messages dialog is 

available from the Options menu.   

 

 

Figure 23 Messages Dialog 
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Configure 

The Configure button provides access to the Configure Messages dialog shown in Figure 

24.  This dialog provides access to preferences associated with messages.  Display 

preferences can be set to filter the types of messages (category) displayed in the 

Messages dialog.  Export Preferences control how the time tag is added to the filename 

that is created when messages are exported.  See the Export section for details.  Message 

storage defines the maximum number of messages that will be stored in memory while 

the application is running.  Once the maximum is reached, older messages are deleted to 

make room for new messages.  The Set to Defaults button can be used to reset these 

properties to application defaults.   

 

 

 

Figure 24 Configure Messages Dialog 

 

 

Clear 

The Clear button provides access to the Clear Messages dialog shown in Figure 25.  This 

dialog provides two ways to clear application messages stored in memory.  You can clear 

all the messages or clear selected messages.  Once you clear messages, the messages are 

permanently deleted in all views (Main Window Message Area and the Messages dialog).   

 

 

Figure 25 Clear Messages Dialog 

 

Export 
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The Export button provides the capability to save all the application messages currently 

in memory to a file.  When you push the Export button you will be prompted for a 

directory and filename.  Export will save all messages in memory, not just the messages 

currently displayed in the Messages dialog (i.e. the Display Preferences are not applied).  

The name you provide for the file will be modified with a time tag that is added to the 

filename.  The time tag indicates the time the file was closed.  The default is to append 

the time tag to the filename.  For example: 

 

Filename Input:   messages.txt 

Filename Output: messages_2017-05-07_13~03~28.txt 

 

If you would like to prepend the time tag to the filename you can set this preference in 

the Configure Messages dialog.  This would result in the following: 

 

Filename Input:   messages.txt 

Filename Output: 2017-05-07_13~03~28_messages.txt 

 

 

Delog 

The Delog button provides the capability to save all application messages generated since 

the application was started.  Delog will retrieve the messages from the temporary log file.  

When you push the Delog button you will be prompted for a directory and filename.  A 

timetag is not applied to the filename. 

 

Filename Input:   messages.txt 

Filename Output: messages.txt 

 

6.7 Application Configuration File 

The Generator application saves the following information when you save a 

configuration:   

 

➢ Contents of the Service List. 

 

6.8 Application Settings 

The Generator application saves some settings as application settings each time you exit 

the application.  The next time you run the application, the application will initialize with 

the previous application settings.  Only one set of settings are saved.  If you run multiple 

instances of the application, the settings in the instance that is exited last will be saved.  

The following application settings are saved: 

 

➢ Application Window Size 

➢ Configure Messages Selections 

➢ Statistics Configuration 
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7 FAQ and Troubleshooting 

This section addresses Frequently Asked Questions and provides tips for troubleshooting 

common gotchas. 

 

No FAQs Yet. 

 

 

 


